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Reports
The QAD GTTE Reports module, powered by Logi Analytics, enables you
to generate and export detailed reports about your shipping activity. It is
also possible to schedule reports and send the results to specific email
addresses.

This help content details how to configure the Reports module to generate
reports.

Each report is built using a catalog and a business view. A catalog
describes the tables in the database that are needed to run the report.
A business view describes the query used to build the report, and how
the entities in the catalog are related. Queries and global formulas can
aggregate, calculate, or condition output on the reports.

Note Logi Report includes Web Report Studio, Page Report Studio,
JDashboard, and Visual Analysis. QAD GTTE uses a subset of the
functionality available in the Web Report Studio. It does not include Page
Report Studio, JDashboard, or Visual Analysis. This section of the QAD
GTTE online help describes the Report Console user interface and the
options relevant to QAD GTTE users.
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Reports Fundamentals
This help content describes the fundamental building blocks used to
generate reports.

Each report is built using a catalog and a business view. A catalog
describes the tables in the database that are needed to run the report.
A business view describes the query used to build the report, and how
the entities in the catalog are related. Queries and global formulas can
aggregate, calculate, or condition output on the reports.

Note Logi Report includes Web Report Studio, Page Report Studio,
JDashboard, and Visual Analysis. QAD GTTE uses a subset of the
functionality available in the Web Report Studio. It does not include Page
Report Studio, JDashboard, or Visual Analysis. This section of the QAD
GTTE online help describes the Report Console user interface and the
options relevant to QAD GTTE users.
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Report Components
Web Report Studio uses a set of components to present and control the
report data and presentation. These components include:

• Labels

• Images

• Database fields (DBFields)

• Formulas

• Summary formulas

• Parameters

• Special fields containing system information such as the date or time

• Web controls for parameter, filter, and navigation control

• Lines

• Pages breaks

• Tabular layouts

• Geographic maps

• KPIs, which include values and charts

• Tables

• Crosstabs

• Banded objects, which present grouped data and detailed data in a
precise layout

• 2D charts such as bar, line, and pie charts

You can bind tables, crosstabs, charts, banded objects, KPIs, and
geographical maps with a data source. Those components are also data
components.

Note QAD GTTE uses labels, images, database formulas, summary
formulas, parameters, and tables to create reports. The other components
are outside the scope of the online help, but there are some references to
them.
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Business View Elements
A business view contains database connections and relationships
between view elements. A business view shields report end users from
having to understand the underlying structure of a data source, and
enables them to create complex reports containing multiple components
and analyze data based on a set of view elements that are easily
understood. A business view can contain the following elements, which
appear in the Resources panel when viewing report results in Edit Mode:

• Categories. Category objects contain a collection of view elements.
A business view may contain more than one category. The Category

Object  icon indicates that an object is a category. Categories are
only for categorizing view elements, and you cannot insert categories
into reports. Categories often indicate the names of the underlying
Database Management System (DBMS) tables.

• Group objects. Group objects are view elements that become the
basis for analysis in a report. They characteristically return text or date

values. The Group Object  icon indicates that an object is a group
object. You can insert a group object as a column or row field in a
crosstab, as a group field or detail field in a table or banded object, or
as a category/series field in a chart.

• Detail objects. Detail objects provide additional information. The Detail

Object  icon indicates that an object is a detail object. You can
insert a detail object into a table or banded object as a detail field.

• Aggregation objects (including custom aggregations). Aggregation
objects are numeric view elements that are calculated dynamically at

runtime. The Aggregation Object  icon indicates that an object is
an aggregation object. You can insert an aggregation object into the
group header or footer in a table or banded object, or into a crosstab
as an aggregate field. You can also use an aggregation object as
a detail field in a table. Web Report Studio calculates the summary
values based on the group level that the aggregation object is at. An
aggregation object is the only object that can provide the value on a
chart.
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Report Console
The Reports page (option LRC) displays the Report Console, where you
can generate web reports that provide insights into current operations
within a number of QAD GTTE modules.

Note In some parts of the user interface, you may see references to
the Report Server. The terms Report Console and Report Server are
interchangeable. Similarly, there are references to Logi Report, Logi
Report Designer, and Logi Report Engine in PDF documents linked to
from this section of the online help. Logi Report and Logi Report Engine
are other terms for the Report Console. Logi Report Designer is another
tool used internally by QAD GTTE development to produce the predefined
reports and the catalog.
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Predefined QAD GTTE Reports
QAD GTTE provides a number of predefined reports that you can use as
a starting point to create reports that are customized to your organization.
It is recommended that you do not change these predefined reports.
Instead, if you have the appropriate permissions, you can create new
reports using the Save As option available when you edit a report.

The table below lists the reports available in QAD GTTE. QAD GTTE
updates these reports on an ongoing basis, adding new reports as
needed. The report updates are published and shared with customers by
the QAD Services team.

Note Publishing an updated collection of predefined reports automatically
overwrites any existing reports with the same name in your Report
Console. If you wish to preserve old versions of reports, you must back up
these reports in a separate folder to prevent them from being overwritten
during later publications.

Predefined Reports Provided by QAD GTTE

QAD GTTE
Module

Report
Name

Description Catalog

Partner
Report

Details parties set up as
partners in the solution.
You can extract all
partners for a given
client. Additional report
parameters allow you
to further categorize the
results by address book
and partner role.

Product
Report

Details goods set up as
products in the solution.
You can extract all
products for a given
client. Additional report
parameters allow you to
categorize the results by
the product's country of
origin and classification.
You can also include
product commodity
codes for EU, US, and
Singapore customs.

Core Information

User Listing
Report

The User Listing section
of the report provides
the last login date, within

QAD-
GTTE.cat.xml
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QAD GTTE
Module

Report
Name

Description Catalog

a specified date range,
for each user in the
system. If a user has
not logged in within the
specified date range, the
last login date for that
user is shown as None.
The information is listed
by user ID.
The Users by Date
section of the report
provides the list of users,
within a specified date
range, who logged
into the system on a
particular date. The
information is listed by
date.
This report replaces
the legacy User Count
Assessment (UCA)
report.

User Report Lists all of the users that
are configured from the
menu option US in the
GTTE application.

Shipment
Cost Report

Details shipment
transaction costs for a
specified date range.
You can generate the
report based on carrier
and customer.

Shipment
Item Report

Summarizes shipment
item data for a specified
date range.

Shipment
Pack
Summary
Report

Details shipment
package information for
shipments within a given
despatch date range.

Transportation
Execution

Shipment
Summary
Report

Summarizes transaction
data for a specified
date range. By default,
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QAD GTTE
Module

Report
Name

Description Catalog

the report gathers
information on shipment
transactions but you
can run the report on
multiple transaction
types.

Workflow
Task Status
Report

Details the status of
workflow tasks for
shipments within a given
despatch date range.

Shipment
Summary
with Delivery
Status
Report

Summarizes shipments
and includes DEM
tracking status
information.

Note The tracking
information is at the
shipment level. For a
multi-piece shipment,
where the deliveries
have different tracking
numbers, the report
shows information
based on one of the
undelivered packages.
If all packages are
delivered then the
overall tracking status is
reported as delivered.

Late
Deliveries
Report

Details the delayed
deliveries that occurred
within a specified time
period. The SupplierId
parameter in the
selection criteria for the
report shows supplier
IDs based on your user
view configuration.

Delivery
Exception
Management

Pending
Deliveries
Report

Details pending
deliveries for a specified
supplier or all suppliers.
The SupplierId
parameter in the
selection criteria for the
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QAD GTTE
Module

Report
Name

Description Catalog

report shows supplier
IDs based on your user
view configuration.

Export
Management

Shipment
Item Export
Classification
Report

Details US/EU/SG
ECCN information for
shipments within a given
despatch date range.

Custom Tab
- Hierarchy
Data Report

Details the Custom
Tabs and all descendant
entities for a specific
client.

Flex Domain
- Hierarchy
Data Report

Details the Flex
Domains and all
descendant entities for a
specific client.

HS Country
Group -
Hierarchy
Data Report

Lists the Harmonized
System country groups
and all descendant
entities for a specific
client.

Partner
Master
Report

Details each partner
in the system. The
report includes a CSV
list of the partner roles
that each partner is a
member of.

Import Trade
Compliance

Partner Role
Report

Details the partner
or partners that are
allocated to each role in
the system.
One row is allocated
to each partner role. If
a partner has multiple
roles, a row is included
for each partner role for
that partner.
Partners without
assigned roles do not
appear in the report.

QAD-GTTE-
ITC.cat.xml
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QAD GTTE
Module

Report
Name

Description Catalog

PGA Flag
- Hierarchy
Data Report

Returns the PGA flags
and all descendant
entities for a specific
client.

PGA Flag
Report

Returns the PGA flags
for a specific client.
The report has one
row for each PGA flag
record. It includes a CSV
list of countries, where
overrides are configured
for each PGA flag.

Product
Classification
Invalid
Commodity
Report

Provides an overview
of the product
classifications with an
invalid commodity code.
The report has one
row for each product
classification. It includes
Product Master details.

Product
Classification
Invalid
Secondary
Commodity
Report

Provides an overview
of the product
classifications with
an invalid secondary
commodity code.
The report has one
row for each invalid
secondary commodity
code in a product
classification. It includes
Product Master and
product classification
details.

Product
Classification
Report

Summarizes
classifications for each
product. The report
includes Product Master
details and a summary
of data from certain child
entities.
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QAD GTTE
Module

Report
Name

Description Catalog

Product
Commodity
Report

Details the product
commodities. The report
has one row for each
product classification
and includes Product
Master details.

Product
Custom
Attribute
Report

Details custom attributes
that are assigned to a
product classification.
The report has one
row for each product
classification custom
attribute. The report
includes the Product
Master details and
product classification
details.

Product
Export
Control
Report

Summarizes Product
Export Control details.
The report has one
row for each Product
Export Control record.
The report includes the
Product Master details.

Product
Master
Report

Summarizes the Product
Master records.

Purchase
Order
Header
Report

Provides an overview
of the header-level
attributes for purchase
orders.
The report has one row
for each purchase order.

Purchase
Order Import
Header
Report

Provides an overview
of the header-level
attributes for import
purchase orders.
The report has one
row for each import
purchase order. It
includes the header-
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QAD GTTE
Module

Report
Name

Description Catalog

level attributes for the
import purchase orders.

Purchase
Order Import
Item Report

Provides an overview
of the import item-level
attributes in a purchase
order.
The report has one row
for each import item in
the purchase order. It
includes header-level,
import header-level, and
item-level attributes for
the purchase order.

Shipment
Charge
Report

Summarizes the
shipment header and
charge level attributes.
The report includes the
shipment header-level
attributes.

Shipment
Header
Report

Summarizes the
shipment header-level
attributes.

Shipment
Import
Header
Report

Summarizes the
shipment import header-
level attributes. The
report includes the
shipment header-level
attributes.

Shipment
Import
Header EU
Report

Summarizes the
shipment import header-
level attributes for the
EU. The report includes
the shipment header-
level and shipment
import header-level
attributes.

Shipment
Import
Header US
Report

Summarizes the
shipment import header-
level attributes for the
US. The report includes
the shipment header-
level and shipment
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QAD GTTE
Module

Report
Name

Description Catalog

import header-level
attributes.

Shipment
Import Item
Report

Summarizes the
shipment import item-
level attributes. The
report includes the
shipment header-level,
shipment import header-
level, and shipment
item-level attributes.

Shipment
Item Report

Summarizes the
shipment item-level
attributes.

Shipment
Payment
Report

Summarizes the
shipment header-level
and payment-level
attributes.

Shipment
Party
Override
Report

Provides an overview
of the shipment header
and partner override-
level attributes. The
report has one row for
each shipment partner
override. The report
includes the shipment
header-level attributes.

Supplier
Status
Tracker
Report

Details the supplier
status trackers in the
system.
The report includes
the associated Partner
Master details for each
supplier status tracker.

You can view the available predefined reports by navigating to
the Resources page and selecting the Root > Public Reports >
GTTE_Reports folder. This page contains a folder for each module.
(Single left) click the module name to open the folder with the related
reports.
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Report Module Categories

All of the predefined reports are based on two catalog files, gtte.cat.xml
and QAD-GTTE-ITC.cat.xml. The gtte.cat.xml file is located in the Root
> Public Reports > GTTE_Reports folder. The QAD-GTTE-ITC.cat.xml
is located in the Root > Public Reports > GTTE_Reports > Import Trade
Compliance folder. The files are only visible to administrators. Do not
make any changes to these files.
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Report Console User Interface
This section describes the Report Console user interface and the options
relevant to QAD GTTE users. When you access the Reports page (option
LRC), the Report Console opens on the Root folder of the Resources
area.
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System Toolbar
The system toolbar appears at the top of the Report Console pages
and, depending on your permissions, contains a number of menus and
options.
System Toolbar

• The QAD GTTE Reports icon or your company logo is located at the
left of the system toolbar. Clicking the icon takes you to your Web UI
home page.

• Resources: Provides access to the User Directory, which contains the
report folders and catalog. When you click this option, the Resources
screen opens, and the Resources menu appears below the system
toolbar. Below the Resources menu, you can view the path to your
current location in the user directory. The three main folders below
the Root folder are Public Reports, My Reports, and My Shared.
Public Reports contains the predefined QAD GTTE reports in the
GTTE_Reports folder. You can use My Reports to store reports that
you have edited and saved for your own use. My Shared stores any
reports shared with you by other QAD GTTE Reports users. Sharing
of reports is beyond the scope of this online help.

• My Tasks: Shows your tasks–reports you have scheduled to run.
When you click this option, the My Tasks screen opens, and the Tasks
menu appears below the system toolbar. Below the My Tasks menu,
you can view the path to your current location in the My Tasks area.

• My Profile: Allows you to modify your profile. When you select one of
the options in this menu, the relevant page opens, and the My Profile
menu appears below the system toolbar. Below the My Profile menu,
you can view the path to your current location in the My Profile area.
Do not use the Change Password option in this menu. QAD GTTE
manages Report Console passwords and user accounts.

• Administration: Allows you to view and modify certain administrative
settings. When you select one of the options in this menu, the relevant
page opens, and a related menu appears below the system toolbar.
Below the menu, you can view the path to your current location in the
Administration area.

• Search: Offers a Report Console search feature.

• Home: Provides access to the Start page, or home page, of the
Report Console. The Start page contains links to various menu
options. The Create Web Report option allows you to create a web
report using the Report Wizard. When creating the report, select the
catalog file and then specify the fields from the business views that
you want to include in the report. Ignore the Create Page Report
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option because it does not apply to the QAD GTTE Reports module.
Similarly, ignore the Contact Support link and the logout icon.

• Settings: Do not use the options in this menu. QAD GTTE manages
garbage collection and restarting of the server, and these menu
options are not in use.

• Help: Provides access to learning materials from Logi. You can
access Logi’s Feature Guide, User’s Guide, and the Logi Report
Home Page. Demos and tutorials are also available. Not all of this
information applies to QAD GTTE Reports. Ignore the Contact
Support link and direct any questions to QAD Services.

• User Profile: Displays your login information and a link to change your
password. Important: Do not use the Change Password option. QAD
GTTE manages the password for each Report Console user account
to ensure that it corresponds with the password for the related QAD
GTTE user account. For more information, see Managing Users,
Roles, Privileges, and Permissions on page 1947.
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User Directory
On the left of all pages apart from the Start page, there is an arrow that
you can click to open and close the User Directory view. This view allows
you to quickly navigate the report folders.
User Directory

1915



QAD Online Help

Report Actions
When you mouse over a report in the Resources area, a number of action
icons appear to the right of the report name.
Report Action Icons

• Run. Run the report and open the results in View Mode. For more
information, see Manually Running Reports on page 1918.

• Advanced Run. Run the report with additional options to produce the
result in a different file format. For more information, see Manually
Running Reports on page 1918.

• Edit. Run the report and open the results in Edit Mode. For more
information, see Configuring Report Contents in Edit Mode on page
1926.

• Schedule. Schedule the report to run at a particular time. For more
information, see Scheduling a Report to Run on page 1939.

• Version. This option is not currently utilized by QAD GTTE Reports.

• Properties. View the report properties, including permissions and
available business views.

Note Do not modify permissions at the report level. In QAD GTTE,
permissions are set at the folder level. For more information, see
Managing Permissions on page 1958.

• Parameter Settings. Customize the default parameter values for a
report. Settings include the Re-enable Parameter Screen option.
When this option is unselected, the next time the report runs through
operation in the Report Console, it will use the default parameter
values directly without popping up the Enter Parameter Values dialog
box.

• Share. Share a report. Sharing of reports is beyond the scope of the
online help.

• Delete. Delete the report.
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Working with Reports
This section describes how to run reports manually or automatically, and
how to create your own reports from the predefined reports provided by
QAD GTTE. Depending on your permissions, you may be able to create
and run reports. You may also be able to edit existing reports to show
fields that are more suited to your needs.
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Manually Running Reports
1. From the Root folder, navigate to the relevant folder and locate the

report that you want to run. Hover over the report name to see a list
of icons. Each icon represents an action that you can perform, and a
tooltip identifies the action. Click the Run icon for the chosen report.
Running a Report

Note The Report Console also offers an Advanced Run action

. You can use this command to run the report immediately after
specifying additional specifications, including what output format to
use (HTML, PDF, Text, Excel, Postscript, Rich Text Format (RTF), or
XML), which style group to apply, and any encoding options.

2. In the Enter Parameter Values pop-up window, complete the
required fields (identified by an asterisk). You can choose to save the
parameters that you enter as default parameters for this report.
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Report Parameter Values

3. To generate the report, click Submit.

The report result displays in a new browser window in View Mode.
Report Result
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Analyzing Report Results in View Mode
After you manually run a report, the report opens in the Web Report
Studio in View Mode. The report is shown as a table. You can scroll
through the report pages using the arrows below the table. The toolbar
above the table can include the following options:

• New (available in Edit Mode only)

• Open (available in Edit Mode only)

• Save

• Save As

• Export

• Page Setup

• Print

• Share (available in Edit Mode only)

• Refresh

• Undo (available in Edit Mode only)

• Redo (available in Edit Mode only)

• Query Filter

• Filter

• Close Responsive Mode

• Quick Schedule (not available in Edit Mode)

• Delete (available in Edit Mode only)

To customize the toolbar, click the Customize Toolbar Items icon  and
adjust the selected options as required.

The toolbar also includes a double chevron icon on the left, which allows
you to expand or collapse the Parameters and Filter panels.
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Parameter and Filter Panels

To the right of the toolbar icons, use the drop-down menus to choose
between:

• Viewing all of the data in the report, or a subset of the data, using the
Full Data or Partial Data options. The Partial Data feature enables
you to set the number of records that can be retrieved by all data
components in a report. When running a report that contains a large
amount of data, it can be helpful to retrieve only a specific number of
records for better performance. For example, if you are making a lot of
changes to the report, it may be faster to limit the number of records
to one page.

• Viewing the report in View Mode or Edit Mode.
Switching to Edit Mode
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Applying Filters to a Report
You can apply filters to business views and data components, such as
tables, in a web report to narrow down the data in the web report.

You can apply filters to report results in either View Mode or Edit Mode.

Applying a Filter to a Report Using the Filter Panel
You can apply a filter to each data component in a report individually, or
use the Filter panel and filter controls to filter multiple data components at
a time.

To filter from the Filter panel:

1. On the title bar of the Filter panel, click the + icon.
2. The Select Fields dialog box lists all the group and detail objects in

the business views that the current report uses. Navigate through the
fields and select a field to filter the data on.

3. The Apply To drop-down menu allows you to select the data
components in the report to apply the filter to. Keep the default Apply
To setting.

4. Click OK.
5. The Filter panel should now include a filter box with all values of the

selected field.
6. In the Filter panel, click the field value that you want to filter the report

on. You can use the Ctrl or Shift key to select multiple values. If the
values themselves have a relationship, after you make the selection,
the Report Console deals with the rest of the values to put the related
ones on the top and gray the ones that have no relationship with the
selected values. The grayed values are still selectable.

Note Filtering is case-sensitive; for example, filtering a currency field
based on a value of EUR produces different results than filtering on a
value of eur.

7. You can add multiple filters in the filter panel; for example, you can
use two filters to see all of the closed USD shipments. To add another
filter to the filter panel, repeat the previous steps.
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Filter Panel with Multiple Filters

Applying a Filter to a Report Using the Query Filter
You can use the Query Filter option to apply a filter to the business view
that a data component, such as a table, uses:

1. Do any of the following to open the Query Filter dialog box:

◦ Select Menu > Edit > Query Filter.

◦
Select the Query Filter button  on the toolbar above the report
results.

◦ Right-click a data component (table column) and select Query
Filter from the shortcut menu.

◦ For a table, chart, crosstab, or banded object, while creating or
editing it with the report wizard, select the Filter button next to the
Data Source drop-down list.

2. If you accessed the dialog box from the menu or toolbar, select a data
component from the Apply To drop-down list to filter the business view
it uses.

3. Specify the filter to apply to the business view.

The Query Filter drop-down list includes all the predefined filters of the
business view that the specified data component uses. Choose the
one you want to apply to the report. If you want to further edit the filter,
select the Edit button and then redefine the filter. The system saves
the edited filter as a user-defined filter to the business view.

If you prefer to define a filter on your own, select User Defined from
the Query Filter drop-down list, then define the filter according to your
requirements.

The dialog box has basic and advanced modes for you to define a
filter using either simple expressions or complex expressions.
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To define a filter using simple expressions:

a. Ensure that the dialog box is in the basic mode.
b. Select the field on which the filter will be based from the field drop-

down list.
c. From the operator drop-down list, select the operator with which to

compose the filter expression.
d. Type the values to filter the field in the value text box, or select

one or more values from the drop-down list.

When you see More... at the end of the value list, you can select it
to open the Select Values dialog box, which lists more values, and
select the values you want.

When you type multiple values manually, you should separate
them with ",", and if "," or "\" is contained in the values, write it as
"\," or "\\". To specify an empty string as the value for a field of
String type, simply leave the text box blank (value length=0).

You can also select the Enter Parameter Values  button
and then select a parameter from the list to specify the value
dynamically. When the available parameters cannot meet your
requirement, you can create a local parameter for the filter.

e. If you want to add another condition line, from the logic operator
drop-down list:

▪ To add a condition line of the AND relationship with the current
line, select And, then define the expression as required.

▪ To add a condition line of the OR relationship with the current
line, select Or, then define the expression as required.

You can repeat this to add more condition lines. To delete a
condition line, select the Delete button on its left.

To define a filter using complex expressions:

a. Select Advanced to switch the dialog box to the advanced mode.
b. Select Add Condition to add a condition line.
c. From the field drop-down list, select the field on which the filter will

be based.
d. From the operator drop-down list, select the operator with which to

compose the filter expression.
e. Type the values to filter the field in the value text box, or select

one or more values from the drop-down list.

When you see More... at the end of the value list, you can select it
to open the Select Values dialog box, which lists more values, and
select the values you want.
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When you type multiple values manually, you should separate
them with ",", and if "," or "\" is contained in the values, write it as
"\," or "\\". To specify an empty string as the value for a field of
String type, simply leave the text box blank (value length=0).

You can also select the parameter button  and then select
a parameter from the drop-down list to specify the value
dynamically. When the available parameters cannot meet your
requirement, you can create a local parameter for the filter.

f. To add another condition line, select Add Condition and define the
expression.

g. Select the logic button until you get the required logic to specify
the relationship between the two filter expressions. The logic can
be AND, OR, AND NOT, or OR NOT.

h. You can repeat the preceding steps to add more condition lines.
i. To group some conditions, select them and then select Group.

The system adds the selected conditions in one group and they
work as one line of the filter expression. You can further group
conditions and groups together.

j. To take any condition or group in a group out, select it, and then
select Ungroup. It is the equivalent of adding parentheses in a
logic expression.

k. To adjust the priority of a condition line or a group, select it and
select Up or Down.

l. To delete a condition line or a group, select it, and then select
Delete.

Note When the dialog box is in the basic mode and you select a
predefined filter from the Query Filter drop-down list which is a
complex one, the system switches the dialog box to the advanced
mode automatically.

4. Select OK to apply the filter. If you open the Query Filter dialog box
from the report wizard, the system applies the specified filter to the
business view after you finish the wizard.

If the filter conditions use parameters, the system lists the parameters
in the Parameters panel. You can then specify the parameter values in
the panel to dynamically define the filter conditions.

1925



QAD Online Help

Configuring Report Contents in Edit Mode
After you manually run a report, the report opens in the Web Report
Studio in View Mode. You can switch to Edit Mode and configure the
report by adding or removing columns (data components). In Edit Mode,
there are additional icons and a menu in the toolbar above the report
result that are not available in View Mode:

• A new drop-down Menu allows you to open 5 submenus:

◦ File. This menu includes options to create a new report and to
copy the existing report by saving it under a new name in a new
location.

◦ Edit. This menu allows you to access the table wizard to modify
the report table.

◦ View

◦ Format

◦ Help

• New icon

• Open icon

• Share icon

• Font icon

• Background Color icon

• Align icon

• Merge icon

• Split icon

As with the toolbar in View Mode, you can customize the toolbar to show
or hide the icons listed above.

There are additional icons to show or hide details of the table and to add
or remove groups of data from the table.

Edit Mode also includes a vertical Visualization toolbar to the left of the
report table. The first icon in this toolbar relates to the Table Wizard.
The other toolbar icons allow you to convert the report results from table
format to a crosstab, banded object, or one of a number of different chart
types including a bar chart and pie chart.

Modifying a Report in Edit Mode
To modify the report in Edit Mode:

1. On the report result toolbar, use the drop-down menu on the right to
switch from View Mode to Edit Mode.
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2.
In Edit Mode, on the Visualization toolbar, click the Table Wizard 
icon.

3. In the Table Wizard window, in the Details tab, review the contents of
the Resources box and select a field that you want to add as a column
(data component) in the report table. When a field is selected, click

the right arrow  to move the field into the box on the right.

Note The fields available depend on the catalog and business view
used to create the original report.
Table Wizard

4.
When a field is selected, click the right arrow  to move the field
into the box on the right.

5. When the field appears in the right box, use the up and down arrows
above the box to move the field up or down in the list. This position
determines the location of the new column in the report result table.

Note Do not drag fields up and down in the right box–ensure that you
use the up and down arrows to change the position of fields.

6. Review the label listed for the field, and update it if necessary.
7. Click OK to save the changes.
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Creating Dynamic Resources and Local Parameters in
Edit Mode
In Edit Mode, you can create dynamic formulas, user defined-functions,
dynamic aggregations, and local parameters in your reports.

When you add fields to a report or use parameters to define filter
conditions in a report, sometimes you may find that the predefined view
elements in the business view or the given parameters in the current
catalog cannot meet your requirements. In those cases, you can create
dynamic resources (including formulas and aggregations) and local
parameters in the report and use them to get the desired data. Then,
when you save the report, the Report Console saves the dynamic
resources and local parameters along with the report as its resources.

In addition, when there are changes in a business view, users with the
administrators role can recompile the dynamic resources in reports that
use the business view as the data source so that the dynamic resources
can work normally.

Dynamic resources are accessible from the Resources panel.
Dynamic Resources in Resources Panel

To recompile the dynamic resources in reports upon changes in business
views:

1. On the system toolbar of the Report Console, select Administration >
Other > Batch Refresh Dynamic Resources.

2. In the Batch Refresh Dynamic Resources page, click Browse to
choose the catalog where the changed business views reside, from
the server resource tree. All business views are currently based on
the gtte.cat.xml catalog file located in the Root > Public Reports >
GTTE_Reports folder.
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Batch Refresh Dynamic Resources Page

3.
Click the ellipsis  button to choose a folder in which there are
reports that run with the preceding catalog from the server resource
tree. You can recompile dynamic resources based on one catalog
and one folder at a time. If your server's workload and performance
allow, and you have enough time, you can choose a parent folder that
contains all such folders, or simply choose the root directory of the
server resource tree if you are not quite clear about where the reports
are. Otherwise, start from a folder without a subfolder in it and do the
work multiple times.

4. Select OK to start recompiling the dynamic resources in the reports
that run with the specified catalog, in the specified folder (including
its subfolders). The process might take a long time depending on the
quantity of the dynamic resources to recompile and the reports to
refresh.

Creating and Using Dynamic Formulas
Note You should have some knowledge of the formula syntax before you
can successfully compose a formula without errors. To learn about the
syntax, see the Formula Syntax section of the Logi Report Designer v18
documentation, which is accessible from the Help menu in the system
toolbar on page 1913.

To create a dynamic formula:

1. In the Resources panel, expand the Dynamic Resources > Formulas
node, then select <Add Formula…>. The Report Console displays the
Formula Editor.
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Formula Editor

2. Type a name for the formula in the Formula Name text box.
3. By default, the system determines whether it can use the formula as

an aggregation object, and if not, uses it as a detail object. You can
specify to use the formula as a detail, group, or aggregation object, by
selecting the corresponding view element type from the Use As drop-
down list on the toolbar.

Whether you can use a dynamic formula as a certain type depends on
the following rules:

◦ You can use any formula as Detail.

◦ You can use any formula that references a DBField excluding an
aggregation as Group.

◦ You can use a formula that refers only to aggregations as
Aggregation. For example, there are two aggregations Sum_Total
and Sum_Quantity, and you can create a formula @"Sum_Total" /
@"Sum_Quantity" and use it as an aggregation.

◦ You can use a formula that follows the custom aggregation
expression as Aggregation. For more information, see the
Custom Aggregation section of the Logi Report Designer v18
documentation, which is accessible from the Help menu in the
system toolbar on page 1913.

4. Compose the formula by selecting the required fields, functions
including built-in functions and user-defined functions, and operators
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from the Fields, Functions, and Operators boxes respectively. You can
also enter the formula in the editing box. For more information, see
Formula Functions and Formula Operators sections of the Logi Report
Designer v18 documentation, which is accessible from the Help menu
in the system toolbar on page 1913.

5. Click the Check button to check whether the syntax of your formula is
correct.

6. Click OK to create the formula.

After you create a dynamic formula, you can then drag it from the
Resources panel to the desired position in the report for data analysis,
add it as a report field when working with the report wizard, or use it to
create expressions in the Formula Editor.

If you want to further edit an existing dynamic formula, remove a formula
that you do not want any longer, or change the formula type to Group,
Detail, or Aggregation, right-click the formula in the Resources panel
and then select the corresponding command on the shortcut menu. You
cannot delete dynamic formulas when you have used them in the report.

Using User-Defined Functions
When you create dynamic formulas to use in a report, if the built-in
functions do not satisfy your requirements, you can make use of the User
Defined Function feature to create any functions that you want. When you
save the report, GTTE Reports saves the functions into the report as its
resources in the same way that it saves dynamic formulas. User-defined
functions can also call other user-defined functions.

To create a user-defined function:

1. In the Resources panel of Web Report Studio or the Resources box
in the Web Report Wizard, expand the Dynamic Resources > User
Defined Functions node, then select <Add Function…>. The system
displays the User Defined Function Editor.
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User Defined Function Editor

2. Enter a name for the function in the Function Name field.
3. Compose the function by double-clicking the required fields, functions

including built-in functions and other user-defined functions, and
operators from the Fields, Functions, and Operators boxes. You can
also enter the function manually in the editing box.

The function syntax is:

arguments: VariableType1 VariableName1, VariableType2
VariableName2, ...;

For example, arguments: integer age, string name;

An argument works the same as a local variable except that you
cannot assign any value to it, like arguments: integer age=10.

4.
Select the Check button  to check whether the syntax of your
function is correct.

5. Select OK to create the function.

The Report Console displays the function under the User Defined
Functions node in the Functions box of the Formula Editor and User
Defined Function Editor. You can call it in a dynamic formula or another
user-defined function by double-clicking it.

For example, a user-defined function named function1 is: arguments:
integer age, string name; and you can call it as follows:
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• @function1(25, "John Smith");

• @'function1'(25, "John Smith");

• @"function1"(25, "John Smith");

If you want to further edit an existing user-defined function or remove a
function that you no longer want, right-click the function in the Resources
panel and then select the corresponding command on the shortcut menu.
You cannot delete functions when you have used them in the report.

Creating and Using Dynamic Aggregations
In the Report Console, you can also create dynamic aggregations by
mapping them to the available resources such as group objects, detail
objects in the current business view, and the dynamic formulas that you
have created in the report.

To create a dynamic aggregation:

1. In the Resources panel of the Report Console, expand the Dynamic
Resource > Aggregations node, then select <Add Aggregation…>.
The Report Console displays the Add Aggregation dialog box.
Add Aggregation Dialog Box

2. In the Aggregation Name field, enter the display name of the dynamic
aggregation. Or you can leave the name blank. Then, when you finish
selecting the mapping name and the aggregate function, the system
automatically provides a name here.

3.
Select the ellipsis button  next to the Mapping Name text box.
The system displays the Select Resource dialog box.

4. Select the field on which the dynamic aggregation is based.
5. From the Aggregate Function drop-down list, select the aggregate

function. When you select DistinctSum, you should select the ellipsis

button  next to the Distinct On text box. The system displays the
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Select Fields dialog box. Select one or more group and detail objects
according to which unique values to calculate DistinctSum from. For
more information, see the Aggregate Functions section of the Logi
Report Designer v18 documentation, which is accessible from the
Help menu in the system toolbar on page 1913.

6. Click OK to create the dynamic aggregation.

The Report Console adds the dynamic aggregation in the Resources
panel. You can then drag it to the desired position in the report for data
analysis, add it as a report field when working with the report wizard, or
use it to create expressions in the Formula Editor. If you want to edit any
dynamic aggregation or delete it, right-click the aggregation and select
Edit or Delete on the shortcut menu.

Creating and Using Local Parameters
When you use parameters to compose the filter conditions to apply to a
report, if the given parameters in the current catalog cannot meet your
requirements, you can create local parameters to use in the report.

To create a local parameter and use it in a filter:

1. When you filter a business view in the Query Filter dialog box,
or a data component using the Filter dialog box, select the Enter

Parameter Values  button and then select <Add Parameter…>
from the Local Parameters node of the value drop-down list.
Add Parameter Option

The system displays the Add Parameter dialog box.
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Add Parameter Dialog Box

2. In the Name field, type a name for the parameter.
3. Select a parameter type from the Value Setting drop-down list.
4. In the value section, specify the parameter values as required. The

section varies with the type you select from the Value Setting drop-
down list.

For Type-in Parameter:

a. Select the data type of the parameter values from the Value Type
drop-down list.

b.
Select the Add button  to add a value line, double-click in it and
then type a value of the specified data type.

If the parameter is of Date, DateTime, or Time type, you can also

select the Calendar icon  to set a date and time value using
the calendar.

c. Repeat the preceding step to add more values.
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d.
To adjust the order of the values, select the Up button  or the

Down button .
e. To remove any unwanted value, select it in the list and then select

the Remove button .
f. To make a value the default selected value for the parameter,

select it from the list.

For Bind with Single Column:

The system provides a mechanism that links each value of the display
field with the exact value of the bound field for a parameter. When
you select a value of the display field, the system actually sends the
value of the bound field to the query and filters the query result. This
can help you bind the parameter to a data field in order to provide a
list of values for report users to select, which probably makes more
sense. The system uses the selected value of the bound field as the
parameter value. For example, it might be confusing if you provide a
list of customer ID numbers for the report users to select at runtime,
since the ID numbers would probably mean nothing to them. In cases
like this, it is better for you to display values of other fields, which
would make more sense. For this case, you might prefer to display
customer names instead of ID numbers. When the report user selects
a customer name from the list, the system passes its ID number to
the query as the parameter value so that the search criteria can be
fulfilled.

a. From the Source drop-down list, select the required business
view in the current data source from which to get data for the
parameter. All the group and detail objects in the specified
business view will be available for retrieving values for the
parameter.

b. Select a field from the Bind Column drop-down list, to filter the
query when running a report with the parameter.

c. If you want the values of another field to display for the report
users to choose from, select that field from the Display Column
drop-down list.

For Bind with Cascading Columns:

a. From the Data Source drop-down list, select the required business
view in the current data source from which to get data for the
parameter. All the group and detail objects in the specified
business view will be available for retrieving values for the
parameter.

b.
Select the Add button  to add a parameter row.
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c.
Select the arrow button  in the Bind Column cell and then
select a field from the drop-down list.

d. If you want the values of another field to display for the report

users to choose from, select the arrow button  in the Display
Column cell and select that field from the drop-down list.

e. Select in the Parameter cell to create the parameter. The system
automatically adds a name for the parameter.

f. Repeat steps b to e to create more parameters. Make sure that
the selected Bind Column fields are of cascading relationship one
level by one level down. In this way, you can create a group of
cascading parameters.

g. To adjust the order of the parameters, select the Move Up button

 or the Move Down button .
h. To remove any unwanted parameter from the cascading group,

select it, and then select the Remove button .
5. In the Options box, set the properties of the parameter.
6. Select OK to create the parameter. The system adds the parameter to

the Local Parameters node in the Parameters list.
7. To further edit the parameter, right-click it in the list and select Edit

from the shortcut menu. Then, in the Edit Parameter dialog box, edit
the parameter as you want.

8. To remove the parameter, right-click it in the list and select Delete on
the shortcut menu.

9. Finish defining the filter condition using the parameter.
10. Select OK to apply the settings. Server lists the parameter in the

Parameters panel. You can specify the parameter value in the panel
to dynamically set the filter condition.

Important   
• You can only use JDK (not JRE) to compile formulas and user-defined

functions that you created in Web Report Studio and save them with
no errors into a web report.

• Currently, you cannot use global variables in dynamic formulas and
user-defined functions.

• If you refer to any field in a formula or user-defined function, add a
prefix @ before the reference name for that field. If the field name
contains spaces, quote the reference name with double quotation
marks (""). For example, if the field name is Customer Name, then the
reference name will be @"Customer Name".

• When formulas and user-defined functions reference display names
or mapping names, the names should not contain any of the following
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characters if you do not quote the names by double-quotation marks
"":

"~", "`", "!", "@", "#", "$", "%", "^", "&", "*", "(", ")", "-", "+", "=", "{", "}",
"[", "]", "|", "\\", ":", ";", "\", " ' ", "<", ",", ">", ".", "?", "/"

Examples:

• Expression @Customer#; will cause a syntax error. But
@"Customer#" is OK.

• If a field has the display name Category.Aggregation, quote it as
"Category.Aggregation" or "Category"."Aggregation".
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Creating Reports For Your Own Use
You can use existing predefined QAD GTTE reports to create reports that
are customized to your own needs. To do this, run a predefined report
in Root > Public Reports > GTTE_Reports and then view it in Edit Mode
to adjust it to your needs. After you have made the adjustments, in Edit
Mode, select File > Save As to save the new report with a new name in a
folder of your choice; for example, in Root > My Reports. This approach
keeps the predefined reports unchanged so that they are available for
other users. It also ensures that your adjusted report is not overwritten
when the predefined reports in Root > Public Reports > GTTE_Reports
are updated through the publication process.

An important point to note is that the predefined reports and any reports
that you create based on these reports are dependent on the catalog and
business views related to the original predefined report. If the catalog
and business views are updated in a future publication, these updates
will apply to the original predefined report but not to any reports that you
created from it. The publication process overwrites any existing reports in
the target folder that share a name with an updated report for publication.

Scheduling a Report to Run
You can use the Report Console to schedule reports to automatically
run at one or more designated dates and times. Scheduled reports
can greatly improve the performance of the reporting service in an
organization. For example, you can run reports during low network traffic
times. Scheduled reports can also capture a time period exactly; for
example, the last day of the quarter.

You can monitor the status of scheduled reports by viewing the My Tasks
page, which is accessible from the system toolbar. The Running table
lists the reports that are currently running. The Completed table lists the
scheduled reports that have completed running. The Scheduled table lists
the reports that are scheduled but have not yet run.

In this example, we set up a schedule to output a weekly report to an
email address.

1. In the Resources page of the Report Console, navigate to the Public
Reports > GTTE_Reports folder.

2. In the GTTE_Reports folder, click the folder for the module that you
want to run a report on.

Note A Search field at the top left of the page allows you to search for
a specific report name.

3. In the module folder, mouse over the specific report row and click
the Schedule icon that appears to the right of the report name in the
floating toolbar.

4. In the <Report Name> [Schedule] page’s General tab, in the Schedule
Name field, enter ScheduledReportToEmail.
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5. Click Next.
6. In the Parameter tab, specify the report parameters and then click

Next.
7. In the Publish tab, click the To E-mail tab.
8. Click New and add an email recipient in the To field.

Note Ensure the correct report format–for example, Excel–is selected
at this stage. If you want to compress the mail attachment as a ZIP
archive, select Compress Attachment as Java Archive.
Configuring the Email Contents

9. Click OK to confirm the email address and attachment details.
10. Click Next.
11. In the Conditions tab, specify the time at which you want to perform

the scheduled report task to run.
12. In the Time tab, choose Run this task periodically from the Time Type

drop-down list. Select Weekly from the Date drop-down list and define
it to repeat every week on Sunday. Select At from the Time drop-down
menu and specify the time as 2:00 AM.
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Configuring the Email Time

13. Click Next.
14. It is best practice to configure a notification in the Notification > Failed

Task tab so that, if the scheduled report run fails, the nominated
person gets a notification by email. You can also configure a
notification for the case when the report is successful.
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Configuring Failed Task Notification

15. To create this scheduled report, Click Finish.
16. Click OK on the Task Submitted Successfully message that appears

on the screen. This message includes a task ID.

The status of a scheduled task can be seen on the My Tasks page.

Running a Scheduled Report Manually
Sometimes it's not practical to wait until a particular time to view the result
of a scheduled report. To run the report and view the result immediately:

1. In the My Tasks page of the Report Console, click the Scheduled tab.
2. In the Scheduled tab, review the listed tasks to locate the scheduled

report that you want to run manually. Mouse over the Schedule Name
for the report and click the Run icon that appears to the right of the
report name in the floating toolbar.
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Note Before running the task, you can click the Properties icon 
to edit any settings, such as the email address. After running the task,
ensure that you revert the settings for the scheduled task.

3. In the pop-up message that appears on the screen, click OK.
4. Check your email inbox for the report.
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Deleting Resources
Resources, including folders, that are no longer needed can be removed
from the server resource tree in the Resources page of the Report
Console. You can delete one or more resources at a time. To delete a
resource:

1. Browse to the folder where the resources are located.
2. Select the checkboxes of the required resources. To delete all the

resources, select the top checkbox.
3. Right-click in any selected resource row and select Delete from the

shortcut menu.

If you just want to delete a single resource, hover over the resource

row and select the Delete button  on the floating toolbar to delete it.

Note Shared web reports can only be deleted by their owners from the
My Shared folder.

Note The built-in resource folders cannot be deleted.

Note Deleting a resource or folder removes the resource or folder from
disk. The deleted resources and folders cannot be retrieved. Any relevant
versions belonging to the resource will also be deleted.
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Reports Administration
The Administration menu allows you, as the report administrator, to
manage the Report Console resources, databases, configuration,
and security. If you have the requisite permissions, you can configure
the Report Console so that users can run reports and receive email
notifications of report results. The Administration menu is accessible from
the system toolbar.
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Configuring the Email Server
In order for users to publish reports to email and to notify the task status
by email when scheduling tasks to run reports, administrators need to
configure an email server in advance. These steps describe how you can
configure an email server on the Report Console.

1. On the system toolbar of the Report Console, navigate to
Administration > Configuration > E-mail Server.
E-mail Server Configuration

2. In the E-Mail Server page, complete the available fields:

◦ SMTP Server, SMTP Server Port, Encoding. These fields are
configured by QAD GTTE and you do not need to make any
changes to them.

◦ E-mail Address. Specify the address of the email sender. Ensure
that the format of the specified address is valid; for example,
noreply-logireports@qad.com.

3. To apply the settings, click Save.
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Managing Users, Roles, Privileges, and
Permissions
To use the Report Console, you must have a user account with a role
assigned to that user.

Note In QAD v20, 20.1, and v20.2, QAD GTTE users do not automatically
have user accounts or roles in the Report Console. Report administrators
must add users to the Report Console before users can access it. The
roles in the Report Console are separate from the roles in the QAD GTTE
Web UI. For more information about Report Console roles, see Report
Console Roles, Privileges, and Permissions on page 1948.

Note From QAD GTTE v20.3, QAD GTTE users with access to menu
option LRC are synchronized to the Report Console and given the
"everyone" role in the Report Console by default. A background process
performs this synchronization. It is not necessary to manually create the
user in the Report Console.
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Report Console Roles, Privileges, and Permissions
The actions you can perform in the Report Console depend on the Report
Console role assigned to your user account. There are in-built roles
provided with the Report Console:

• Administrators. This role allows you to access and perform the
administrative tasks listed in the Administration menu of the Report
Console. Administrators also have full access–Visible, Read,
Write, Delete, Execute, Edit, Schedule, Grant, and Update Status
permission–to the report resources. This role cannot be deleted.

• Everyone. This role provides restricted access to report resources
and, by default, does not allow you to delete, add, or copy reports.
This role cannot be deleted.

Administrators can assign a role to a user using the Administration >
Security > Role menu option. Administrators can also use this option to
create new roles. For each role, you can select the privileges associated
with that role. For each role, at the folder level, you can define the
permissions that the role has.
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Report Console Users
To run reports and perform other tasks in the Report Console, you need
a user account. Each user must have at least one role. At the resource
level, you can define what the role can do.

Users of the Reports module fall into one of three categories:

• Report Administrator. These users have the administrators role, which
provides them with access to all of the functionality in the Report
Console, including:

◦ Creating and publishing reports for use by other users.

◦ Creating users in the Report Console and assigning appropriate
permissions to these users through roles.

◦ Configuring user settings to enable scheduled reports to be sent to
specified email addresses.

• Report User. These users have the everyone role, which provides
them with access to a subset of the functionality in the Report
Console, including:

◦ Running existing predefined QAD GTTE reports manually.

◦ Scheduling existing predefined reports to run at a specified time or
time interval.

◦ Editing existing report results.

◦ Copying predefined reports to create new reports that are more
suited to users’ individual needs.

• Report Consumer. This role is not defined within the Report Console
as these users do not have access to the console. These users
receive the results of scheduled report runs by email.
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Managing Users
The system allows you to create a user, edit the roles that a user has, and
delete a user.

Creating A User Account
To use the Report Console, you must have a user account. The Report
Console has two built-in user accounts, admin and guest. You cannot
delete the built-in user accounts. The admin user account cannot be
deleted or disabled.

Note Report Console users are not automatically created for QAD GTTE
user accounts. You must explicitly create a Report Console user account
for a QAD GTTE user who needs this access. Ensure that you choose a
Report Console user name that matches the QAD GTTE user name but
with any letters in uppercase. You do not need to specify a password. The
password from your QAD GTTE user account carries over to the Report
Console user account, provided you use the same user name.

To create a user account:

1. On the system toolbar of the Report Console, click the Administration
drop-down menu and select Security > User.
User Option in the Administration Menu

2. In the User page, select New User from the taskbar.
3. In the New User pop-up window, complete the fields with any user

information you would like to use and click OK to create the user.
New User Button

If you want to disable the user for now, select the Account Disabled
checkbox.

Note The Publish privilege is an important aspect of user definition.
You can either grant or deny users the ability to publish resources to
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the Report console using this checkbox. QAD Services handle the
publishing of updated reports to customer environments; do not grant
this permission to any other users. The Advanced Properties privilege
allows you to view advanced resource properties information. For
more information on privileges, see the Managing Privileges section.
New User Pop-Up Window

The new user is listed in the user table.

Editing the Roles a User Holds
You can assign more than one role to a user. A user that holds multiple
roles has all the privileges that these roles have.

1. On the system toolbar of the Report Console, click the Administration
drop-down menu and select Security > User.

2. In the User page, locate the relevant user in the table and, in the Edit
Roles column, click the roles link for that user.
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Editing a Role

3. To add a role to the user, select Add Roles, select the new role, and
then select Add. To remove a role from the user, select the role and
then select Remove. After you remove a role from a user, the user no
longer has the privileges that the role owns.

Editing the Scheduling Recipients for a User
GTTE Reports adopts permission control on the scheduling recipients
that a user can access. This approach means that when a user schedules
a report task to publish reports to email, if the user has the required
permission, the user can send the reports to email addresses of particular
users, groups (QAD GTTE does not use the Groups feature), and roles.
These are the basic rules on which users, groups, and roles are available
as the scheduling recipients of a user by default:

• An administrator (the user with the administrators role) who does not
belong to any organization can see all the users, groups, and roles in
the GTTE Reports security settings. The permission is unchangeable.

• A normal user (the user without the administrators role) can see
themselves only.

• An administrator in an organization can see all the users, groups, and
roles in the organization. The permission is unchangeable.

• A normal user in an organization cannot see users, groups, and roles
outside of the organization.

• A user, group, or role inherits the permissions from its parent users,
groups, and roles.

An administrator can customize the scheduling recipients that are
available to a normal user:

1. In the user table, select the recipients link for the user. The Report
Console displays the recipient list for the user.
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Recipients Link in the User Table

2. Select Add Recipients. The Report Console displays the recipients
that you can choose.

3. Select the recipients that you would like to be accessible to the user.
4. Select Add. The Report Console displays a confirmation message.
5. After you confirm the update, the recipients you selected appear on

the recipient list.
6. To remove a recipient from the user, select it in the recipient list and

then select Remove.
7. When the user schedules reports to run and be sent by email, the

user will be able to select the recipients from the Select Role, Group
and User dialog box to use their addresses to send the email.

Setting User Preferences
An administrator can configure the preferences of a user:

1. In the user table, select the Preference link for the user. The Report
Console displays the preference settings for the user in a pop-up
window.
Preferences Link in the User Table

2. Specify the server preferences for the user, and the Default and
Advanced properties you want the user to use in Web Report Studio.

◦ Default Format for Viewing Report. The default format for viewing
reports. By default, Web/Page Studio is selected, which means
that web reports open in Web Report Studio (GTTE Reports does
not support page reports).
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◦ Open All Reports in New Window. By default, the Report Console
displays Web Report Studio in a new window. Clear this property if
you want to embed them in the current window.

◦ Use Wizard for Web Report Studio. You can create web reports
using two methods: the quick start method to create a table
report, which is the default method when you clear Yes, and the
traditional method using a wizard when you select Yes.

◦ Only Display CSS Styles in Style List. By default, the Report
Console displays only the CSS styles in the style list.

◦ Keep Completed Tasks for. The number of days the Report
Console keeps the completed tasks in the Completed list. The
default value 0 means the Report Console keeps the completed
tasks until you delete them from the Completed page.

◦ Columns Shown in _ List. Select the columns you want to
display as default in the following list when you sign in to the
Report Console: Report Tabs, Scheduled, Running, Completed,
Background Tasks, Report Result Versions, Report Versions,
Catalog Versions, and Result Versions.

3. Select OK to accept the changes.

Deleting a User
You can delete a user account if it is no longer required. However, you
cannot delete the built-in user accounts such as admin and guest, users
that hold roles other than the everyone role, or users that belong to any
group (QAD GTTE does not use the Groups feature). You cannot delete
your own user account from the user table.

1. On the system toolbar of the Report Console, click the Administration
drop-down menu and select Security > User.

2. In the User page, locate the relevant user in the table and, in the last
column, click the Delete link for that user.
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Managing Roles
Managing roles includes many functions and they are available to
administrators only. This section describes how you can create roles,
add members to roles, customize the scheduling recipients for roles, and
perform other role functions.

Creating a Role
To create a role:

1. On the system toolbar of the Report Console, click the Administration
drop-down menu and select Security > Role.

2. In the Role page, select New Role from the taskbar.
3. In the New Role pop-up window, complete the fields with any user

information you would like to use and click OK to create the user.

◦ Role Name Specify the name of the role.

◦ Parent Role Name Specify the name of the role.

◦ Description Parent role name.

◦ Privileges

Select Advanced Properties to give the role the privilege
of viewing advanced resource properties information. QAD
Services handle the publishing of updated reports to customer
environments; do not grant this privilege to any other users.
For more information on privileges, see Managing Privileges on
page 1957.

4. Click OK to create the new role. The role appears in the role table.

Editing a Role
To edit a role:

1. On the system toolbar of the Report Console, click the Administration
drop-down menu and select Security > Role.

2. In the Role page, click the relevant role name in the table and, in the
Edit Roles column, click the roles link for that user.

3. In the New User pop-up window, add or remove the Advanced
Properties privilege for the role and click OK.

Note For more information on privileges, see the Managing Privileges
section.

Editing the Members of a Role
To edit the members of a role:

1. On the system toolbar of the Report Console, click the Administration
drop-down menu and select Security > Role.
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2. In the Role page, locate the relevant role in the table and, in the
Members column, click the members link for that role.

3. In the Edit Members page, review the member list of the role. To add
a member to the role, click Add Members, select the new member,
and click Add.

Note A role can have more than one child group, child role, and
parent role. You cannot add a parent role to a role as its child. You
cannot remove some members from the role they belong to, such as
admin in the administrators role and guest in the everyone role. You
cannot remove your own user from the administrators role.
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Managing Privileges
The Privileges page allows you, as an administrator, to grant and revoke
privileges for users and roles. QAD GTTE Reports does not allocate
privileges on a user or group basis. The available privileges are:

• Publish. When you have the Publish privilege and Write permission on
a folder in the user directory, you are able to publish resources to the
folder.

• Advanced Properties. This privilege allows you to view advanced
information about version properties such as catalog connections and
report-related resources.

Note By default, only the administrators role and the admin user account
have the Publish and Advanced Properties privileges. QAD Services
handle the publishing of updated reports to customer environments; do
not grant this privilege to any other users.

To manage privileges:

1. On the system toolbar of the Report Console, click the Administration
drop-down menu and select Security > Privilege.

2. Select a role in the Selected box, then select or clear the required
privileges.

If a role or user is not listed in the Selected box, select it in the

Available box and select the Add button  to add it to the
Selected box first, then grant it the privileges accordingly.

You can make use of the Search box to search for the required roles
in the Available or Selected box. After typing text in the Search box,
you can select the Search Option arrow  in the box to specify the
following search options: Highlight All, Match Case, and Match Whole

Word. To cancel the search operation, clear the text or select .

3. To remove all privileges from a role, user, or group, first select it in the

Selected table, then select the Remove button . Server adds the
role back to the Available box with no privileges.

4. Click OK to apply the changes.

Note You can also grant privileges to users and roles while creating or
editing the users and roles.
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Managing Permissions
The Permissions page allows you, as an administrator, to grant and
revoke permissions for roles. QAD GTTE Reports does not allocate
privileges on a user or group basis.

The permissions a role has are resource-specific. To view or modify
the role permissions for a given resource, select the checkbox next to
the resource; for example, Public Reports, and then select Properties.
From the Permissions page, you can edit the permissions for the role–
assuming you have the Grant permission.

Note It is possible to grant permissions at a more granular level. For
example, you can define permissions at the report level or the data level.
However, QAD GTTE defines reports at the Public Reports level, as
indicated by the Enable Setting Permissions option.

The available permissions are:

• Visible. This permission allows you to view object names in the
resource tree or version table, such as folders, resources, and archive
versions. QAD GTTE does not use the versions capability of the
Report Console.

• Read. This permission allows you to view object properties, versions,
and, if it is a folder, folder contents.

• Write. This permission allows you to change the properties (excluding
permission settings) of the objects in the resource tree or version
table, such as folders, resources, and archive versions, and modify
version table settings.

• Delete. This permission allows you to delete objects from the resource
tree or version table, such as folders, resources, and archive versions.

• Execute. This permission allows you to access View Mode of the Web
Report Studio.

• Edit. This permission allows you to access Edit Mode of the Web
Report Studio.

• Schedule. This permission allows you to submit resources to
schedules.

• Grant. This permission allows you to grant permissions to other users,
groups, or roles. You need to be an administrator to assign the Grant
permission to other users, groups, or roles. Users, groups, or roles
that have obtained the Grant permission are also endowed with the
other permissions, and users can then grant these permissions–
except the Grant permission itself–to other users in the same group.

Note In QAD GTTE, permissions are granted at the role level only.

• Update Status. This permission allows you to update a report status
and, if it is a folder, the status of reports in the folder.
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To run reports in public folders in the resource tree, you must have the
Execute and/or Edit permissions on the reports, and the Visible/Read
permissions on the catalogs that the reports use.

You may need more than one permission to complete a task. For
example, you must have both the Visible and Read permissions to view
the properties of a report.

Some permissions depend on other permissions, such as Write, Execute,
Edit, and Schedule. Allowing any one of these will also allow the Read
permission.

To manage permissions:

1. On the Root folder, in the Public Reports row, click the Permissions
icon.
Permissions Icon

2. On the Resources page, click the Permissions tab.
3. In the Permissions tab, ensure that the Enable Setting Permissions

checkbox is selected.
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Permissions Tab in the Resources Page

4. Select Role.
5. Select a role in the Selected box, then select or clear the required

permissions.

If a role is not listed in the Selected box, select it in the Available box

and select the Add button  to add it to the Selected box first,
then grant it the privileges accordingly.

You can make use of the Search box to search for the required roles
in the Available or Selected box. After typing text in the Search box,
you can select the Search Option arrow  in the box to specify the
following search options: Highlight All, Match Case, and Match Whole

Word. To cancel the search operation, clear the text or select .

6. To remove all the enabled permissions from a role, first select it in the

Selected table, then select the Remove button . The system adds
the role back to the Available box with no permissions.

To remove permissions for all roles on the resource, clear Enable
Setting Permissions.

7. Click OK to apply the changes.

Note After you have set permissions for a parent folder, any
new resources and subfolders in that folder will inherit the same
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permissions. If you do not want them to inherit these permissions,
you can enable their user permissions and set their permissions
separately. Resources and folders will inherit permissions from their
parent folder if you don't enable their user permissions.
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